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Windows XP 
 
 

XP Speed Secret #1: Disable Extra Startup 
Programs 
 
There are certain programs that Windows will start every time you 
boot up your system, and during the startup phase, they're all 
competing for a slice of your CPU speed. Extra or unwanted items 
in the startup list will definitely increase your startup time, perhaps 
by several minutes. Some common examples are things related to 
AOL, RealPlayer, Napster, instant messengers, and video managers.  
 
If you're not sure about an item, no big deal. You can turn it off, 
restart your PC, and see if everything seems to work. If not, you can 
always go back and re-enable an item in the Startup list.  This tip 
alone should speed up your start-up by 250%.  Here are is what 
you have to do: 
 

1. Go to Start button  Run 
2. Type "msconfig", without quotations 
3. Hit enter key or click the OK button 
4. A System Configuration Utility window will show up 
5. Click the Startup tab  
6. In the Startup tab you will see several boxes and some of them 

will selected (checked). All you have to do is to uncheck 
extra items that are of no use. If you run an antivirus 
program it is not recommended to uncheck it. 

7. After making you choices press the OK button, you will be 
prompted to restart computer to apply changes. 

8. After restarting your computer a dialogue will be displayed. 
You can check the option for not showing this dialogue every 
time your PC reboots. 
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XP Speed Secret #2: Remove Spyware, Adware, 
and Malware 
 
Have you scanned your system for spyware, adware and other 
unwanted pests? 1 of 6 computers has some sort of Spyware or 
Malware! They dramatically slow down your computer because they 
use resources to generate popup ads, send spam, and often 
interfere with the operation of good programs. 
 
If you haven’t scanned recently, we recommend a free scan from a 
good anti-spyware program.  We prefer to use stand-alone, high 
quality anti-spyware programs like XoftSpy Pro, which give us the 
ability to scan and repair these problems in seconds.   
 
FINAL NOTE: Recent testing has shown that stand-alone programs 
do a much better job than the “all-in-one” packages (eg. Norton 
Internet Security) at detecting spyware, adware, and malware. 
 

 
 

 
 

http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
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XP Speed Secret #3: Optimize Display Settings 
 
Windows XP can look sexy but displaying all the visual items can 
waste system resources. To optimize: 
 

1. Click the Start button 
2. Select Control Panel 
3. Double-click the System icon 
4. Click the Advanced tab 
5. In the Performance box click Settings 
6. Leave only the following ticked: 

a. Show shadows under menus 
b. Show shadows under mouse pointer 
c. Show translucent selection rectangle 
d. Use drop shadows for icons labels on the desktop 
e. Use visual styles on windows and buttons 

7. Finally, click Apply and OK 
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XP Speed Secret #4: Speed-Up File Browsing 
 
You may have noticed that every time you open “My Computer” to 
browse folders that there is a slight delay. This is because Windows 
XP automatically searches for network files and printers every time 
you open Windows Explorer. To fix this and to increase browsing 
speed significantly: 
 

1. Double-click on My Computer 
2. Click the Tools menu 
3. Select Folder Options 
4. Click on the View tab. 
5. Uncheck the Automatically search for network folders and 

printers check box 
6. Click Apply 
7. Click OK 
8. Reboot your computer 
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XP Speed Secret #5: Reduce Page File Size  
 
Page file size is not constant by default. Due to this, the operating 
system has to resize the file each time more space is required.  This 
is a performance overhead. All you have to do is to set the file size to 
a reasonable limit.  
 
Follow the steps: 
 

1. Right-click My Computer, Select Properties 
2. Click the Advanced tab 
3. Click the Settings button under the Performance section 
4. Click the Advanced tab 
5. Under the Virtual 

Memory section click 
the Change button 

6. "Virtual Memory" 
dialogue box will appear 
(also shown in the figure 
below)   

7. Highlight the C: drive 
containing page file 

8. Select the Custom Size 
radio button and give 
same values in Initial 
size and Maximum size 
fields: 

 
If you have less than 512MB 
of memory, leave the page 
file at its default size. If you 
have 512MB or more, change the ratio to 1:1 page file size to 
physical memory size. 
 

9. Click Set, then OK buttons to apply the changes 
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XP Speed Secret #6: Clean Your System Registry 
 
Of course, the fastest and easiest way to speed-up your computer is 
to allow a software program to do it for you! Although you will find 
that all of the adjustments in this book will speed up your system, 
the most effective and easiest way to give your computer blazing 
speed is to clean up your system’s Registry.   
 
Your computer is like your car: it needs periodic maintenance to 
keep it running at optimum performance.  Installing and un-installing 
programs, surfing the Internet, emailing, and other everyday 
activities create a sort of “sludge” that builds up in your computer 
over time, much like an automobile engine. After a while, it doesn't 
startup like when it was new, it stalls unexpectedly, and performance 
is sluggish on the (information) highway. 
 

 
 
We strongly recommend running a free Registry scan to find out 
how many errors you computer is hiding from you.  Your computer 
will likely have hundreds of Registry errors that are dramatically 
slowing down the potential speed and performance. 

http://www.windowsaccelerator.com/ebook/regcure/
http://www.windowsaccelerator.com/ebook/regcure/
http://www.windowsaccelerator.com/ebook/regcure/
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XP Speed Secret #7: Run Disk Clean-Up 
 
Both Windows and application programs tend to leave temporary 
files lying around on your hard drive, taking up space. A hard drive 
that is close to being “full” can cause Windows to slow down or 
interfere with efficient disk access and virtual memory operations.  
 
If you surf the web a lot, your temporary internet files folder can 
become quite large, causing Internet Explorer to slow down or 
malfunction. Cleaning up unneeded files, scanning for disk errors 
and defragmenting the hard drive can help to restore some zip to 
your system.  Try to run once a month for peak performance. 
 
 

1. Double-click the 
My Computer 
icon.  

2. Right-click on 
the C: drive 

3. Select 
Properties  

4. Click the Disk 
Cleanup button 
(to the bottom-
right of the 
Capacity pie 
graph) 

5. Select / check 
Temporary 
Internet Files 
and Recycle Bin 

6. Click OK 
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XP Speed Secret #8:  Enable Direct Memory 
Access (DMA) 
 

1. Right-click on My Computer, select Properties 
2. Select the Hardware tab 
3. Click the Device Manager button 
4. Double-click IDE/ATAPI controllers 
5. Double-click on the Primary IDE Channel 
6. Click on the Advanced Settings tab (as shown in figure) The 

tab may or may not be available for each option. It is only 
available in Primary and Secondary Channels. 

7. Set the Transfer Mode to "DMA if Available" both for Device 
1 and 0 

8. Click OK 
9. Perform the same operation for other items in the list, if 

applicable. 
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XP Speed Secret #9: Disable File Indexing 
 
Indexing Services is a small little program that uses large amounts 
of memory and can often make a computer endlessly loud and 
noisy. This system process indexes and updates lists of all the files 
that are on your computer. It does this so that when you do a search 
for something on your computer, it will search faster by scanning the 
index lists. If you don’t search your computer often, this system 
service is completely unnecessary. To disable do the following: 
 

1. Click Start button 
2. Select the Control Panel 
3. Double-click Add/Remove Programs 
4. Click the Add/Remove Window Components icon on the left 

side of the window 
5. This may take a few seconds to load.  Be patient. 
6. Look for the “Indexing Services” component in the list 
7. Uncheck the Indexing Services  
8. Click Next 
9. Click Finish 
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XP Speed Secret #10: Remove Un-Used Programs 
& Files 
 
You may have a bunch of software packages on your hard drive that 
are no longer needed, or they were gratuitously installed when you 
downloaded some other package. Toolbars, file-sharing 
programs, free email enhancers, online shopping "companions" 
and download managers are notorious for this practice. These 
uninvited guests can put a big drag on your startup time, cause web 
pages to load slowly, and generally bog down your computer.  
 

1. Click Start button 
2. Select Control Panel 
3. Double-click Add/Remove Programs icon 
4. See what programs are installed that you don’t typically use 
5. Select the Remove button for the ones you know you don't 

need 
 
If you’re unsure about some programs, do a web search to learn 
about the ones that you need to keep. 
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Windows Vista 
 

Windows Vista is a rather heavy operating system with many neat 
features, but unfortunately they all come at a price. As a brand new 
operating system, it requires a pretty fast system to run well, if 
not optimized. 
 
Before you run out and buy a new computer just so you can run your 
base operating system, check out these these simple ways to 
speed-up Windows Vista and lighten the load. 
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Vista Speed Secret #1: Turn-Off User Account 
Control (UAC) 
 
Now, there’s a lot of talk about the new User Account Control 
policy in Vista, and all I can say is that it annoys the heck out of 99% 
of users and slows down normal computer usage. To turn it off, 
the easiest way is to: 
 

1. Click the Start (Windows) button 
2. Select the Control Panel 
3. Type in ‘UAC‘ into the search bar 
4. It’ll bring up a search result of ‘Turn User Account Control 

(UAC) on or off’ 
5. Just follow the prompts from there 
 

 
 
Much better, eh? You might say ‘but what’s that got to do with 
speed?’ It prompts you at least a couple times an hour and then 
takes several seconds to figure itself out. Without these annoying 
prompts, your productivity goes up, so therefore it’s a speed 
enhancer.   
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Vista Speed Secret #2: Disable Unnecessary 
Graphical Effects 
 
Vista is “sexy” because of its new aero glass transparency effects. 
Here is how to enable and disable this new eye candy. 
 
1. Click Start (Windows) button  
2. Select the Control Panel 
3. Double-click Click Appearance and Personalization 
4. Under Personalization, click Change the color scheme 
5. In the Appearance Settings dialog box, click Windows Vista 
Basic, and then click OK.  
 
Or, if you prefer a Windows 2000-style interface, click Windows 
Standard, and then click OK. 
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XP Speed Secret #3: Remove Spyware, Adware, 
and Malware 
 
Have you scanned your system for spyware, adware and other 
unwanted pests? 1 of 6 computers has some sort of Spyware or 
Malware! They dramatically slow down your computer because they 
use resources to generate popup ads, send spam, and often 
interfere with the operation of good programs. 
 
If you haven’t scanned recently, we recommend a free scan from a 
good anti-spyware program.  We prefer to use stand-alone, high 
quality anti-spyware programs like XoftSpy Pro, which give us the 
ability to scan and repair these problems in seconds.   
 
FINAL NOTE: Recent testing has shown that stand-alone programs 
do a much better job than the “all-in-one” packages (eg. Norton 
Internet Security) at detecting spyware, adware, and malware. 
 

 
 

 

http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
http://www.windowsaccelerator.com/ebook/xoftspy/
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Vista Speed Secret #4: Shutdown Search Indexing 
 
Windows Vista Search Indexing is constantly checking the files on 
your system to make their information available for quick searching. 
This is helpful, but can severely slow system performance as the 
average user doesn’t use the search function frequently. 
 
To shut down constant indexing: 
 

1. Click the Start button  
2. Select Computer 
3. Right-click on the C: Drive icon 
4. Select Properties 
5. Select the General Tab 
6. Uncheck Index this drive for faster searching 
7. On the next dialog box, select Apply Changes to Drive C:, 

subfolders and files 
8. Click OK 
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Vista Speed Secret #5: Disable Automatic Disk 
Defragment  
 
Windows Vista uses an always-on defragment set up that isn’t that 
necessary and will cause your system to slow down. Remember to 
run a defragment manually once a month. 

To shut down this feature: 

 

1. Click the Start button 
2. Select Computer 
3. Right-click on C: Drive icon 
4. Select Properties 
5. Click the Tools tab 
6. Uncheck Run on a schedule 
7. Click OK 
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XP Speed Secret #6: Clean Your System Registry 
 
Of course, the fastest and easiest way to speed-up your computer is 
to allow a software program to do it for you! Although you will find 
that all of the adjustments in this book will speed up your system, 
the most effective and easiest way to give your computer blazing 
speed is to clean up your system’s Registry.   
 
Your computer is like your car: it needs periodic maintenance to 
keep it running at optimum performance.  Installing and un-installing 
programs, surfing the Internet, emailing, and other everyday 
activities create a sort of “sludge” that builds up in your computer 
over time, much like an automobile engine. After a while, it doesn't 
startup like when it was new, it stalls unexpectedly, and performance 
is sluggish on the (information) highway. 
 

 
 
We strongly recommend running a free Registry scan to find out 
how many errors you computer is hiding from you.  Your computer 
will likely have hundreds of Registry errors that are dramatically 
slowing down the potential speed and performance. 

http://www.windowsaccelerator.com/ebook/regcure/
http://www.windowsaccelerator.com/ebook/regcure/
http://www.windowsaccelerator.com/ebook/regcure/
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Vista Speed Secret #7: Disable Automatic 
Windows Defender Operation 
 
Windows Defender real-time protection against malware continues 
to run despite having Automatic operation disabled.   
 
In actuality, this built-in malware protector from Microsoft is very 
poor at protecting your computer from external threats.  You are 
much better off using a 3rd-party software program like XoftSpy for 
total protection (see Vista Speed Secret #9 for more information). 
 
To disable: 

1. Click the Start button 
2. Type “services” into the Start Search box 
3. Find Windows Defender in the list of programs 
4. Double-click on Windows Defender 
5. Choose Tools from the top menu 
6. Select Options 
7. Uncheck Auto Start at the bottom of the window 
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Vista Speed Secret #8: Turn-Off Un-Needed 
Features 
 
There are many new features in Windows Vista that are installed by 
default that you may not need. These extra and un-needed features 
can slow down your computer and take up more storage space.  
Windows Features can be un-installed using the Windows Features 
utility. Follow these steps to uninstall applications such as the 
Windows Fax and Scan and many more. 

To Turn-Off Some Un-Needed Features: 

1. Click on the Start Button 
2. Select Control Panel 
3. Under Programs click Uninstall a program 
4. On the left side menu, click on Turn Windows features on or 

off  
5. Scroll through the list as shown below and uncheck from any 

feature you do not want installed. 
6. Click OK when you are finished making your changes. The 

features will now be uninstalled. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 22 

Vista Speed Secret #9: Disable Unused Services 
 
Services are background processes which keep running waiting for 
a response, so if you don’t use the application it still runs and 
slows PC speed.  The average user doesn’t need many running. 
 

1. Click the Start button  
2. Type msconfig in the Start Search box, hit enter 
3. Click the Services tab 
4. Uncheck the unneeded startup items (examples below) 

 
Desktop Window Manager Session Manager - Provides Desktop 
Window Manager startup and maintenance services. Uncheck to 
disable. 
 
Diagnostic Policy Service - Enables problem detection, 
troubleshooting and resolution for Windows components. Uncheck 
to disable. 
 
Diagnostic Service Host - Same as above 
Diagnostic System Host - Same as above 
 
Offline Files - The Offline Files service performs maintenance 
activities on the Offline Files cache. Uncheck to disable. 
 
Terminal Services - Allows users to connect interactively to a 
remote computer. Remote Desktop and Terminal Server depend on 
this service. If you don’t use either of these, then you can disable the 
service. Uncheck to disable. 
 
Windows Error Reporting Service - Allows errors to be reported 
when programs stop working or responding and allows existing 
solutions to be delivered. Uncheck to disable. 
 
After you are finished, click Apply then click OK to save changes. 
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Vista Speed Secret #10: Shutdown Remote 
Differential Compression 
 
Remote Differential Compression checks the changes of your files 
over a network to move them with as little bandwidth as possible 
instead of transferring an entire file that has previously been moved. 
Obiviously, the average home PC user has NO need for this service.  
With it constantly checking for file changes, this service will greatly 
slow system performance. 
 
To shut down this service: 
 

1. Click the Start button 
2. Select Control Panel 
3. Click Classic View on the left side of the window 
4. Double-click on Programs and Features 
5. Click Turn Windows Features On And Off on the left side of 

the window 
6. Uncheck Remote Differential Compression 
7. Click OK 
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Vista Speed Secret #11: Shut-Off Windows 
Hibernation 
 
Windows hibernation background services use a very large amount 
of system resources. If you are like most people you don’t use the 
Hibernate feature very much so you may want to disable it to give 
Vista a performance boost. 

To shut down Hibernation: 

1. Click the Start button 
2. Select Control Panel  
3. Click the Classic View on the left hand side 
4. Double-click on Power Options 
5. Select Change Plan Settings 
6. Choose Change Advanced Power Settings 
7. Click the Sleep “plus” icon 
8. Click the Hibernate After “plus” icon 
9. Adjust your selector down to zero minutes 
10. Click Apply 
11. Click OK 
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Disclaimer 
 
The Windows speed tips presented in this document are provided as 
a courtesy to others. Products mentioned are within the scope of a 
user's need, in our opinion, and may not be appropriate for you for 
your home or commercial use. 
 
While we expect that the information we present here is accurate 
and should be helpful, we make no guarantees as to its accuracy, 
applicability, or adequacy to protect your system or that the 
information is up to date. We do not have experience with all the 
speed tips mentioned on these pages. Products and techniques 
mentioned here may not be appropriate or adequate for your 
individual needs. If you choose to rely on information presented in 
this document, you do so at your own risk. 
 
Do the above procedures at your own risk. 
WindowsAccelerator.com is not responsible for any damage the 
procedures may cause to your computer. 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 


